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products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
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applications and the like is provided only for your convenience
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QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
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AR CONFIGURATION UTILITY (ARCU)
USER’S GUIDE
Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
AR Configuration Utility (ARCU). Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes the installation and use of the AR Configuration Utility 
(ARCU). The Microchip ARCU is a Windows®-based graphical user interface that can 
be used to configure, calibrate, test and demonstrate both the AR1000 and AR1100 
touch screen controllers. Additionally, the AR1100 firmware can be updated 
(re-flashed) via the ARCU. The manual layout is as follows:
• Chapter 1. Installation
• Chapter 2. Getting Started
• Chapter 3. AR Configuration Utility Layout

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2011-2012 Microchip Technology Inc. DS41605B-page 7
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
RECOMMENDED READING
This user’s guide describes how to use the AR Configuration Utility (ARCU). Other 
useful documents are listed below. The following Microchip documents are available 
and recommended as supplemental reference resources.
Readme for AR Configuration Utility (ARCU)
For the latest information on using the AR Configuration Utility (ARCU), read the 
“Readme.txt” file (an ASCII text file) in the main installation directory. The Readme 
file contains updated information and known issues that may not be included in this 
user’s guide.
Readme Files
For the latest information on using other tools, read the tool-specific Readme files in 
the Readmes subdirectory of the MPLAB® IDE installation directory. The Readme files 
contain updated information and known issues that may not be included in this user’s 
guide.

THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: http://support.microchip.com
 2011-2012 Microchip Technology Inc. DS41605B-page 9
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DOCUMENT REVISION HISTORY

Revision A (August 2011)
• Initial Release of this Document.

Revision B (July 2012)
• Added Declaration of Conformity; Added functional support for the AR1011 and 

AR1021 controllers; Changed the title from “AR1100 Configuration Utility” into “AR 
Configuration Utility”; Updated Figures 2-1, 3-1, 3-2, 3-4, 3-6, 3-7, 3-9, 3-13, 3-14 
and 3-15; Updated section 3.1; Other minor corrections.
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AR CONFIGURATION UTILITY (ARCU)
USER’S GUIDE
Chapter 1.  Installation
The Microchip AR Configuration Utility (ARCU) is a Windows-based graphical user 
interface that can be used to configure, calibrate, test and demonstrate both the 
AR1000 and AR1100 series touch screen controllers. Additionally, the AR1100 
firmware can be updated (re-flashed) via ARCU.

The AR1000 can use either the I2C™, SPI or USART based communication protocols, 
while the AR1100 can use USB or RS-232 (serial). To facilitate AR1000 communications, 
Microchip’s USB-based PICkit™ Serial Analyzer is employed to translate 
communications from the host PC to the desired embedded protocol, and visa versa. 
Provided the correct hardware is used, changing protocols in the ARCU is achieved via 
a wizard or a simple options selection.

1.1 INSTALLATION
If installing from a CD, insert the CD into your PC and follow the installation instructions. 
If installing from a zip file, double click on the file, unzip it and follow the installation 
instructions.

Note: This version of the utility (revision 2.20) is the correct one for the AR1011 
and AR1021 part numbers. Previous revisions of the utility will not work with 
these two new devices.

Note: Recommended operating systems include Windows® XP 32- and 64-bit, 
Windows 7 32- and 64-bit. It will require .NET 2.0 to run this application. 
Some installations of .NET 4.0 do not include the .NET 2.0 framework. In 
that case, you will need to download either the 2.0 or 3.5 (Service Pack 1) 
version of .NET.
 2011-2012 Microchip Technology Inc. DS41605B-page 11
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AR CONFIGURATION UTILITY (ARCU)
USER’S GUIDE
Chapter 2.  Getting Started
2.1 GETTING STARTED
• If using either the AR1000 or AR1100 Development kits, follow the Connections 

step in the corresponding Quick Start Guide.
• If using the AR1000, connect the PICkit Serial Analyzer to the PC, the AR1000 

board to the PICkit Serial Analyzer, and a sensor to the AR1000 board. 
Note: Do not use a USB hub.

• If using the AR1100, connect either the USB or serial communications cable to the 
AR1100 board and to the PC. Attach a sensor to the AR1100 board. If using a 
serial connection, apply a 5V power supply to the serial leads (see the AR1100 
PCB User’s Guide for details).

Start the ARCU by double clicking the desktop icon. After the splash screen 
disappears, a welcome screen will appear:

FIGURE 2-1: WELCOME SCREEN

If this is the first time the ARCU has been used, select the Start Wizard icon to step you 
through the configuration process. Follow the steps outlined in the Wizard. If using the 
AR1020 (I2C, SPI) Development kit or the AR1100 Development kit (USB, Serial), have 
the calibration template printed and ready to use.
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After the Wizard is complete, you should have established communications with the 
AR1000/AR1100 and you will be taken to the first tab of the ARCU – the Configuration 
tab. The Transactions window (automatically displayed) will show recent communica-
tions between the ARCU and the controller.
If there were errors, they will appear in red text in the Transaction window. Communication 
errors are generally the result of physical connection or jumper issues. If you have errors, 
check your connections and restart the wizard by pressing the Wizard button on the 
Commands panel (Basic view) or in the Ribbon Tools Group (Diagnostic view).
After you have successfully completed the Wizard, touch the sensor and observe the 
touch reports scrolling in the Transactions window.

Note: If you are using the AR1000 or the AR1020 Development kit, the 
Configuration Wizard may initially ask you to update the PICkit Serial 
Analyzer firmware. If it does, cancel out of the Wizard and press the Update 
PKSA Firmware button on the Commands panel. Allow the firmware to 
update, and then restart the Wizard.
DS41605B-page 14  2011-2012 Microchip Technology Inc.



AR CONFIGURATION UTILITY (ARCU)
USER’S GUIDE
Chapter 3.  AR Configuration Utility Layout
AR CONFIGURATION UTILITY LAYOUT
The ARCU has four tabs, or pages:
• The Configuration Tab
• The Scribble Demo
• The Equalizer Demo
• The P.O.S. Demo

FIGURE 3-1: TABS

The Configuration tab is used to test, calibrate and configure the AR1000/AR1100. 
The remaining tabs display typical AR controller demonstrations. If using the 
demonstration tabs with a sensor in front of the PC screen, make sure the ARCU is 
maximized to ensure proper cursor alignment.

Note: The text of the Configuration tab and the title bar will vary between 
AR1000 and AR1100, depending on how the ARCU is configured.
 2011-2012 Microchip Technology Inc. DS41605B-page 15
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3.1 THE CONFIGURATION TAB

FIGURE 3-2: CONFIGURATION TAB IN DIAGNOSTIC VIEW
DS41605B-page 16  2011-2012 Microchip Technology Inc.



AR Configuration Utility Layout
The AR Configuration page contains all the controls necessary to configure, calibrate 
and test the AR1000 and the AR1100. The Configuration page consists of the following 
areas:
• Ribbon Tools Group
• Ribbon Registers Group
• Commands Panel
• Status Bar

Ribbon Tools Group These are several helper windows used for various 
operations. Press a button to open its window. Each 
window’s purpose is described in Section 3.1.3 “Ribbon 
Tools Group”.

Ribbon Registers The AR1000/AR1100 Configuration registers are logically
Group grouped here. You may change a register’s value directly

through its control. Changes are immediately written to the 
controller’s registers and recorded in the Transactions
window. Hover your mouse over a register control to see
its tool tip description. See the AR1000 or AR1100 data
for more detail about each register.

Commands Panel Various firmware and utility commands and operations are 
located here. Results of a command/operation will be 
displayed in the Transaction window. Hover your mouse 
over a button to see its tool tip description.

Status Bar The status bar, located at the bottom of the GUI, gives 
current information regarding the state of the Configuration 
Utility. The LED in the right corner gives the status of the 
AR1000 or AR1100 connection. The ARCU version number 
is also displayed in the right corner. The touch report rate 
(reports per second) is displayed in the left corner.

Note: The ribbon tools and register groups are not available in the Basic view (see 
Section 3.1.1 “View”).
 2011-2012 Microchip Technology Inc. DS41605B-page 17
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3.1.1 View
There are two views available for the Configuration tab: Basic and Diagnostic. The 
Basic view is a subset of the Diagnostic view, hiding the parameter controls in the 
ribbon and displaying a simplified set of buttons on the command panel. This view is 
sufficient for initial exploration of the AR1000/AR1100 controllers, allowing the user to 
see cursor coordinates, report rates, error messages, etc. Most commands and 
operations are available as well (calibration, enabling/disabling the controller, reading 
registers, etc.).
The Diagnostic view displays the AR1000/AR1100 configuration parameters in the 
ribbon and allows the user to change their values, fine tuning the controller’s response 
for a particular sensor or application.
The view can be changed via the radio buttons on the commands panel (see 
Figure 3-3).

FIGURE 3-3: VIEW CONTROL
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3.1.2 Commands Panel
The Commands panel holds various command and operations buttons and is located 
on either the right or left side of the main screen, depending on the layout preference.

FIGURE 3-4: COMMANDS PANEL

Read Registers Reads the AR1000/AR1100 Configuration registers, 
displays the values on the Transactions window, and then 
updates the register controls in the ribbon.

Register Start Address Sends a command to read the register start address value. 
See the data sheet for more information.

Enable Touch Sends a command to enable touch for the AR1000/AR1100. 
If AR1000 is in I2C or SPI mode, initiates a macro in the 
PICkit Serial Analyzer to read touch reports when AUX2 for 
I2C or Aux1 for SPI, goes high.

Disable Touch Sends a command to disable touch for the 
AR1000/AR1100. If AR1000 is in I2C or SPI mode, disables 
the macro in the PICkit Serial Analyzer used to read touch 
reports.

Save to EE Writes the current register values to the EEPROM and 
updates the displayed values in the EEPROM window (if the 
EEPROM window is open, see Figure 3.1.3.2).
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Restore Defaults Restores default register values to the AR1000 by clearing 
the lower half of the EEPROM and power-cycling the board. 
Cycling power forces the AR1000 to read register and 
calibration values from the EEPROM. However, if EEPROM 
values are cleared, the AR1000 will use default register 
values. For the AR1100, the upper portion of the EEPROM 
is cleared and a Reset command is issued to force default 
values to be used.

Toggle Power Reads VDD being supplied by the PICkit Serial Analyzer, 
turns the voltage off for 250 ms, and then restores VDD and 
pauses for another 250 ms. The effect of this is to power 
cycle the AR1000. This will force it to read register values 
from EEPROM. It has no effect on the AR1100.

Verify Communications Tests communication by sending a command to read the 
PICkit Serial Analyzer firmware version and a command to 
enable touch to the AR1000. For the AR1100, this command 
will also read the registers.

Begin Calibration Sends calibration command to the AR1000/AR1100. A 
calibration panel will appear over the entire computer 
screen with cross hairs appearing, showing where to touch. 
See the data sheet for a detailed explanation of the 
calibration process.

Update PKSA Firmware (AR1000 only) Opens a file selection dialog box allowing the 
user to select a PICkit Serial firmware hex file. Download 
begins immediately after, and requires no user input. The 
GUI will display messages on the Transaction window right 
after start-up, if the firmware needs to be updated.

Update AR1100 Firmware (AR1100 only) Opens a file selection dialog box allowing the 
user to select an AR1100 firmware hex file. Download 
begins immediately after and requires no user input. User 
must select first of a set of three hex files of the form 
xyzBoot.hex.

Reset PKSA (AR1000 Only) Issues a Reset to the PICkit Serial Analyzer. 
This disables any macros running in the PICkit Serial 
Analyzer. This usually is only necessary if a command 
needs to be issued in the Scripts dialog.
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3.1.3 Ribbon Tools Group
The Ribbon Tools Group contains seven windows launch buttons, of which only five or 
six are visible at a time, depending on the protocol being used by the ARCU.

FIGURE 3-5: TOOLS GROUP

3.1.3.1 PICkit SERIAL ANALYZER WINDOW (AR1000 ONLY)

The PKSA window is used to modify the settings of the PICkit Serial Analyzer, including 
which communications mode (protocol) to use.

FIGURE 3-6: PICkit SERIAL ANALYZER WINDOW

Comm Mode Selects the method of communications your device will be 
using. Selecting one of the radio buttons automatically 
configures the PICkit Serial Analyzer, if attached, for that mode. 
The Communications mode is retained from run to run, and can 
only be changed here, in the Options menu, or in the Wizard.

I2C™ This is the default mode. When selected, you may change the 
bit rate by selecting a new value from the drop-down menu.

SPI You can change the bit rate by entering in a value (in MHz) into 
the text box and pressing Update. The PICkit Serial Analyzer will 
configure its bit rate as close as possible to that value and display 
the actual value in the status bar below.

USART There are no configuration options available for USART. The 
baud rate is fixed at 9600 to match the AR1000.

PKSA Will Provide Power Check if you wish to have the PICkit Serial Analyzer 
provide a constant 5V VDD. Uncheck if you will be 
providing external power to the AR1000.
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Read PKSA Button Reads the configuration of the PICkit Serial Analyzer 
and then proceeds to update the control and status bar.

Flash LED Button Causes the PICkit Serial Analyzer to flash one of its 
LEDs (usually the ‘Busy’ LED) for two seconds. You can 
use this to verify communications with the PICkit Serial 
Analyzer.

Connections Brings up a small window displaying the pin out of the 
PICkit Serial Analyzer for a given communication’s 
mode.

Reset PKSA Button Issues a Reset to the PICkit Serial Analyzer. This 
disables any macros running in the PICkit Serial 
Analyzer that would interfere with script execution. This 
button has the same function as the Reset PKSA 
button on the Command panel in the main window.

Status Bar Displays the current configuration parameters.
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3.1.3.2 EEPROM WINDOW

FIGURE 3-7: EEPROM WINDOW

The EEPROM window is used to display and modify the contents of the AR1000 and 
AR1100 EEPROM. There are 256 bytes in the EEPROM, one-half of which are 
reserved for use by the AR1000; the other half is available for user data. Bytes 
0x00-0x7F are used by the AR1000 for register and calibration data. Bytes 0x80-0xFF 
are free to be used by the host without risk of affecting AR1000 operation.
For the AR1011 and AR1021, an EEPROM protection checkbox has been added to 
prevent unexpected results when making changes to the reserved registers section.
For the AR1100, bytes 0x00-0x5F are available for user data; the rest is reserved for 
register and calibration data.
EEPROM ‘profiles’, representing the values in the window, can be saved and opened 
via the File menu, and then written to the EEPROM via the Save button.

File Menu
Open Profile Opens existing profiles as .txt or .csv files.
Save Profile Saves displayed profiles as .txt or .csv files.
Close Closes the window.

Clear Button Clears the contents of the window; does not erase the 
EEPROM.

Status LED Glows bright when the displayed values match the contents of 
the EEPROM; dimmed when the displayed values do not. Note: 
The EEPROM is not actively monitored by the utility; the LED is 
updated in response to user activity.

Read Button Reads and displays the contents of the EEPROM.

Save Button Writes the displayed values to the EEPROM.
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Update Registers Writes the displayed values to the AR1000/AR1100
Button registers.

Erase Button Erases the contents of the EEPROM.

Legend Keywords

Registers Bytes of data that set the controller’s options.

Calibration Data Bytes of data that contain information from calibration.

Reserved These bytes are not recommended for direct modification unless 
directed to by support.

User Data A section of the EEPROM that is available to end users.

Block Key A unique byte indicating the presence of valid data in the next 
data block.

Checksum An 8-bit value that is calculated by starting with the hexadecimal 
value 0x45, then adding all data values in the previous data 
block (including the block key byte) and finally using only the 
lower-byte portion of the calculated sum.

Protected Non-selectable EEPROM area to protect from invalid byte data 
corruption.

3.1.3.3 TRANSACTIONS WINDOW

The Transactions window displays data sent to and received from the 
AR1000/AR1100, status and error messages, and touch report information. Sent data, 
received data and error messages are color-coded. The Transactions window can also 
display .txt and .rtf files. Multiple windows can be open at a time. However, only 
the most recently opened window will display real time information.

FIGURE 3-8: TRANSACTIONS WINDOW

File Menu
Open Opens existing .txt or .csv files. Automatically clears the 

window before opening the file.
Save Saves contents of window as .txt or .rtf files.
Close Closes the window.

Edit Menu
Copy Copies selected text to the clipboard.
Paste Pastes clipboard data to the window.
Select All Selects all of the data in the window.
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Clear All Clears all of the contents of the window.

Clear Button Clears all of the contents of the window.

Report Dashboard Toggles the visibility of the Touch Report Dashboard. The 
dashboard graphically displays the touch report rate, error rate, 
and pen mode.

Text and images can also be typed or pasted into the Transaction window and saved 
along with existing content.

3.1.3.4 SCRIPTS WINDOW

FIGURE 3-9: SCRIPTS WINDOW

The Scripts window is used to create, save, and execute low-level commands. Script 
execution is protocol agnostic. That is; a given script will work with an AR1000 that is 
in I2C, SPI or USART mode or an AR1100 in HID-Generic mode (will not work in 
HID-Digitizer or HID-Mouse mode). To load an existing script, double click the script 
name in the far right panel.
A script consists of two parts; data sent to the AR1000/AR1100 (bytes contained in the 
Script Detail box), and data received in response (expected byte count displayed in the 
Receive Data box). Data sent by and received in response to the script are displayed 
in the Transactions window.
To create a script, enter a name you wish to give it, fill in the bytes in the Script Detail, 
and then enter the expected return byte count in the Receive Data. Save or execute 
the script by pressing the appropriate button. For more information about the format of 
the commands, see the AR1000 or AR1100 data sheet.

Script Name When creating a script, enter a name here.

Save Button Saves the script.

Execute Button Executes the displayed script. Results are shown in the 
Transactions window. Note: For the AR1000, it may be 
necessary to press the Reset PKSA button to disable any 
running macros before a script can be run.

Clear Script Button Clears the current script.
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Reset PKSA Button (AR1000 only) Issues a Reset to the PICkit Serial Analyzer. 
This disables any macros running in the PICkit Serial Analyzer 
that would interfere with script execution. This button has the 
same function as the Reset PKSA button on the Command 
panel in the main window.

Receive Only Button Issues a read command without sending a script. This aids in 
low-level testing of the AR1000/AR1100 by allowing you to 
separate the sending of a script (with 0 expected bytes) and at 
a later time, issue a Read command.

Script Detail Enter the body of the script here. By default, bytes are inter-
preted as hexadecimal. If you wish to use decimal, click on the 
‘x’ in a byte text box to change the radix. Data displayed in the 
Transactions window is always hexadecimal, however.

Receive Data Enter the number of expected return bytes.

Commands Command values; see the AR1000 and AR1100 data sheets 
for information about a specific command.

Loop Scripts may be run for a specified number of iterations, or to 
run continuously, enter an iteration value of 0. The delay 
between each iteration may be adjusted by the Delay control. 
Check the Stop on Error checkbox to stop script iteration in 
the event of an error.

Script Panel The far right panel contains the names of existing scripts. 
Double click the script name to load it.
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3.1.3.5 WIZARD

FIGURE 3-10: CONFIGURATION WIZARD

The Wizard steps you through the process of configuring and calibrating the AR1000 
and the AR1100. If you are using the touch sensor provided in one of the development 
kits, print out the calibration template before beginning the Wizard. You will use this 
template to provide a standard set of calibration points so the movement of your finger 
or stylus on the touch sensor is correctly reflected on your computer monitor.
Depending on your choices in the Wizard, you may be asked to install an optimized 
Configuration register profile. This profile will be written to the EEPROM and reflected 
in the Configuration registers after completion of the Wizard.
The Wizard is one of the choices you have the first time you run the Configuration 
Utility. However, you may run the Wizard again at any time by pressing the Wizard 
button, located in the Tools group in the ribbon in the Diagnostic view, or on the 
Commands Panel when in Basic view.
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3.1.3.6 OPTIONS WINDOW

The Options window contains several parameters that allow you to configure the GUI 
for your particular work environment. Some options are strictly for cosmetic purposes, 
while others allow you to fine tune the GUI according to your computer’s capabilities. 
All options are retained from run to run.

FIGURE 3-11: OPTIONS WINDOW

Restore Defaults Changes all options to their default values.

Enter Demo Mode Hides the Configuration tab and launches the Scribble 
demo. Use this mode to ensure that users do not have 
access to the Configuration registers.

Ribbon Layout Allows you to expand or collapse groupboxes within the 
ribbon. Depending on the size of your monitor, you may 
want to collapse groupboxes you do not use often. If a 
groupbox is collapsed, you can still access its controls by 
clicking on it. Its controls will appear below the ribbon.

Startup Monitor Allows you to choose in which monitor the application will 
start. This option has no effect if there is no secondary 
monitor present.

Show Welcome Screen Check this if you want the welcome screen to open the 
next time you start the GUI.
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Touch Report Buffer Size A typical touch sensor transmits 100 to 200 touch reports 
per second. Computers with slower processors may have 
a difficult time keeping up with the higher rates, so touch 
reports are buffered by the GUI and sent in mass to the 
Transaction window to reduce CPU usage. Increasing this 
value sends updates to the Transaction window less 
frequently and decreases CPU usage. Decreasing this 
value updates the Transaction window more often, but 
increases CPU usage. While the effect of faster updates 
is a more fluid response in the Transaction window, the 
potential danger is dropped bytes in the touch reports due 
to CPU starvation. A good rule of thumb is to keep your 
CPU performance under 50% while touch reports are 
being generated, as indicated by the Windows Task 
Manager.

Mouse Mode This option allows you to change how the GUI interprets 
pen up, down, and move touch reports for the AR1000.
The default method examines the contents of each report 
to make this determination based on the default values 
used in the TouchMode register. Important: If the default 
values are not used in the TouchMode register, this method 
will not work.
Use the Timer-based method if default values are not 
used in the TouchMode register. This mode simply sends 
mouse move events, if touch reports are being generated 
and sends a mouse up event 100 milliseconds after the 
last touch report.

Show Cursor – Config Allows the cursor to be controlled by touch reports on the 
Configuration page. Checking this option will make it eas-
ier to navigate between the Configuration and other tabs, 
but may make it confusing while using touch reporting on 
the Configuration page. For example, while pressing on 
the Transactions window, the window may behave 
strangely because it is trying to update touch reports in 
real time, but also trying to insert the cursor wherever the 
touch is being generated.
It is recommended this option be left unchecked until you 
become familiar with the operation of the AR Configuration 
Utility.

4, 9, 25 Point Calibration Choose how many points to use during the calibration 
procedure. More points will provide more accurate 
tracking, especially for larger sensors. This option only 
applies to the AR1100.

Num Wires Select the number of wires your sensor has. The option 
for 5-wire is not shown since it is hardware selectable on 
both the AR1000 and AR1100 and will override 4 or 8-wire 
selection.

Communication Mode Select which communication protocol you wish to use. 
Press the Test Communication button to initialize the 
protocol in the GUI and attempt communication with the 
AR1000/AR1100.
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Help Dock Allows you to dock the Help panel to the left or right of the 
GUI, or float it as a separate window.

Commands Dock Allows you to dock the Commands panel to the left or right 
of the GUI.

Test This Port First Tells the GUI to try using the port in the accompanying drop 
down first when attempting to find the AR1100. The default 
method is to loop through all available COM ports until the 
AR1100 is found, but this has the possibility of changing port 
settings for another device that is attached.

COM Port Lists all available COM ports found on the PC. Select the 
one to which the AR1100 is attached and check the box to 
the left to have the GUI test communications on that port 
before others.
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3.1.3.7 DIAGNOSTICS WINDOW (AR1100 ONLY)

FIGURE 3-12: DIAGNOSTICS WINDOW

The Diagnostics window is used to run resistance and risetime diagnostics. In order for 
a diagnostic to be generated, the following bits must be set in the AR1100 groupbox in 
the ribbon:
Resistance: Risetime Resistance (RTR)
Risetime: Risetime (RT)
To generate a diagnostic, perform the following steps:
• Set the above bits.
• Disable touch.
• Touch and hold the sensor.
• Press the Touch Check button.
• Enable touch when finished.
The measured resistance and risetime will be displayed in the Diagnostics window and 
the Transactions window will display the commands and responses.
Disable Touch Button Disables touch response on the AR1100. Touch must be 

disabled prior to running a diagnostic.
Enable Touch Button Enables touch response on the AR1100. You should enable 

touch after running a diagnostic.
Touch Check Button Sends a TOUCH_CHECK command to the AR1100.
Diagnostic Results A LED will glow bright green if the diagnostic was 

successfully measured and the value will be displayed along 
side.
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3.1.4 Keyboard Shortcuts

The AR Configuration Utility has a multitude of keyboard shortcuts that can be used to 
quickly navigate through the utility. The included keyboard shortcuts are:

Help Press the F1 key to bring up the Help menu

Command Bar Shortcuts   To use the command bar keyboard shortcuts, first press 
the ALT key, followed immediately by the underlined 
character on the command bar. The letter is capitalized 
here for visibility.

View:

Basic View   ALT + I (I as in Icarus)
Diagnostic View   ALT + N

Commands:
Read Registers    ALT + R

Enable Touch ALT + T
Disable Touch ALT + O

Save To EE    ALT + S
Register Start Address ALT + G

Operations:
Restore Defaults ALT + U

Toggle Power ALT + P
Verify Communications ALT + V

Begin Calibration ALT + L

Start Wizard ALT + W
AR1000/AR1100:

Update PKSA Firmware        ALT + M
Reset PKSA ALT + K

Ribbon Shortcuts To use the ribbon keyboard shortcuts, first press and 
release the ALT button on the keyboard followed by 
pressing two keys according to the list below.

Tools Ribbon:

Diagnostics Window ALT, A, D
EEPROM Window ALT, A, E

Trans Window ALT, A, T

Scripts Window ALT, A, S
Wizard ALT, A, W

Options ALT, A, O
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Thresholds, Delays, Samplings:
Touch Threshold ALT, B, T
Speed Threshold ALT, B, S

Touch Report Delay ALT, B, D
Sleep Delay ALT, B, P
Sampling Fast ALT, B, F
Sampling Slow ALT, B, W

Filtering:
Accuracy Filter Slow ALT, C, W
Accuracy Filter Fast ALT, C, F
Sensitivity Filter ALT, C, S

Calibration:
Calibration Inset ALT, D, I (I as in Icarus)
Enable Calibrated Coord ALT, D, E

Pen Options:
Down Mode ALT, E, D
Movement Mode ALT, E, M
Up Mode ALT, E, U
Up Delay ALT, E, P
State Rprt Delay ALT, E, R

AR1100:
EEV ALT, F, E
CALV ALT, F, L
DRT ALT, F, D
RiseTm Default ALT, F, T
RiseTm Modify ALT, F, M
Dither ALT, F, I
TEN ALT, F, N
Verbose Cal ALT, F, V
DRT ALT, F, W
RT ALT, F, R
RTC ALT, F, C
RTR ALT, F, A
SP ALT, F, S
MM ALT, F, B
 2011-2012 Microchip Technology Inc. DS41605B-page 33



AR Configuration Utility (ARCU) User’s Guide
3.2 THE DEMONSTRATION TABS
The AR Configuration Utility has three tabs that can be used to test and demonstrate 
touch movements: Scribble, Equalizer, and Point-Of-Sale (P.O.S.). 
Ideally, you would have a touch sensor the same size as your computer monitor, or lap-
top screen. Then you could place it over your monitor, attach it to the AR1000/AR1100, 
perform a calibration and use your finger or stylus to interact with the controls on the 
demonstration tabs.
The AR1000 and AR1100 development kits provide an alternative method. You can 
use the included touch sensor along with the templates provided in the Calibration 
Template document to interact with the P.O.S. demonstration tab controls. Print out the 
Calibration Template document (be sure to print it at 100% of its size) and run the 
Wizard located in the Tools group of the ribbon. If you have already run the Wizard and 
have established communications with the AR1000/AR1100, you can also simply press 
the Begin Calibration button on the Commands panel and use the template instead 
of the on-screen calibration points.

3.2.1 Scribble Tab

FIGURE 3-13: SCRIBBLE TAB

Scribble is a simple drawing program. The first set of buttons allows you to increase or 
decrease the width of the pen, clear the drawing, and enter Full Screen mode. The sec-
ond set of buttons allows you to change the color of the pen. The third set of buttons 
allows you change the background color. You also have the option of using this tab in 
Full Screen mode.

Note: When interacting with the demonstration tabs via the templates, the 
AR1000/AR1100 will also control your cursor; however, your mouse is still 
usable.
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3.2.2 Equalizer Tab

FIGURE 3-14: EQUALIZER TAB

This tab demonstrates a graphic equalizer. All of the controls are sliders, except the 
Bass control. To change the Bass control setting, press and hold the Up or Down 
button next to the scale.
The Bass control is different than the rest to demonstrate an alternative technique that 
achieves the same result. Press the Up/Down buttons to change the equalizer value.

3.2.3 P.O.S. Tab

FIGURE 3-15: P.O.S TAB

This is a point-of-sale emulator. Press an item button to add that item to your shopping 
list. The Clear button resets your shopping list. There is also a numeric keypad for 
entering unspecified items.
 2011-2012 Microchip Technology Inc. DS41605B-page 35



AR Configuration Utility (ARCU) User’s Guide
NOTES:
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